B C D F G H | J K
ID Name Designator Footprint Quantity Manufactur Manufactur Supplier  Supplier PaLCSC Assembly
1 HDR-M-2.5¢KJ1,AJ1,BJ1 HDR-M-2.5¢ 8 LCSC C66690
2 NES55P™NA UL DIP-8 1 NES555P TI LCSC C46749
3 MC306(6pF, C1 CAP-D3.0XF 1 HV010MO05( CapXon LCSC C59954
4 0.1u C63,C73  C1210K 2
5 MC306(6pF, C8 C1210 1
6 19-217/GHCLED1,LED2 LED0603-R- 2 19-217/GHCEVERLIGHT LCSC C72043 Yes
7 1N4148W KD1,AD1,BISOD-123FL_ 8 1N4148W Tak CheongLCSC C129216
8 CAP-1uF C2 C0805 1 RVT2A1RON HONOR LCSC C87863
) 9 CAP-1uF C4 RAD-0.1 17
1 10 CAP-1uF G5 R0805 17
2 11 HDR-IDC-2..P1 IDC-TH_6P- 1 2X3 2.54mn BOOMELE LCSC Cl1214
3 12 0.1u KC1,AC1,BCC1210 8
1 13 1IKOHM  R2 R0805 17?
> 14 1KQ R1 AXIAL-0.3 17?
b) 15 2N3906(TO-KQ1,AQ1,B/TO-92-3_L4 8 2N3906 cJ LCsC 9809
7 16 I1m KL1,ALl1,BLI1L0402 8
3

Export BOM supports to export LCSC part price, it is the same as LCSC website.
Notice:

e Before v6.4.17, If your project has schematic and PCB, the BOM data will come from
schematic; if the project only has PCB, the BOM data will come from PCB.

e Since v6.4.17, the schematic BOM and PCB BOM are separated. If you assign the LCSC
part at the PCB, it will not modify the schematic.

e In order to support multiple languages, BOM and coordinate files (CSV file) are UNICODE
encoded and tab-based. If the CSV file cannot be read by your components vendor or
PCB manufacturer, please convert the encoding and change the delimiter.

e Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV
file in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv).
You can also open the CSV file with any text editor (such as Windows Notepad) and save
as ANSI or UTF-8 encoding. If necessary, replace all tabs with commas.

Export NetList

EasyEDA can export the netlist for the whole active project:

File > Export NetList > Spice...



@EasyEDA STD File Edit Place Format View Design Tools Fabrica

| e b g £ *555 Timer - Fla. .
L] Open Project... |. =00 | g |
ij&cl u'_,clpen " I I N (Y N YN N Y I N ) I |
< iy Componen’ I saye . Ctrl+5
EE $EC1(0205] Save As...
Diesign FE£H1 (HDR-
M S As Module. ..
danager EEF_LED"I (LE dve As viodule
T FELED2 (LE [ Import b
EELib EE'F'R1 iDBUE l.';f_l Print...
{F_RE (0305-
3
FER31 (080t XPO

@l Fru1 (soic Export BOM...

Library .+ 5 Mets (6/6) Export Netlist 4 LTspice for This Sheet...
# EasyEDA File Source... Protel/Altium for PCE...
! 24 PADS for PCE...
LESE GND EE
it R1_1 55 FreePCB for PCB...
- _

EasyEDA can export a netlist in a variety of formats:

e LTSpice for this Sheet: this is a Spice compatible netlist generated by the simulation
engine of EasyEDA, It is not normally used as the basis for as a PCB layout.

e Protel/Altium for PCB: a PCB netlist in a format that can be imported straight into
Altium Designer and it's predecessor, Protel.

e PADS for PCB: a PCB netlist in a format that can be imported straight into Pads PCB
layout tools.

e FreePCB for PCB: a PCB netlist in a format that can be imported straight into FreePCB, a
free, open source PCB editor for Windows.

Report Error

For EasyEDA official libraries, we have staffs to draw and maintain(LCSC & JLCPCB Assembled
part) and we will try to keep them correctly as we can, but EasyEDA(System part) included a
lot of open source of the libraries and the official drawing of the libraries, that can not avoid
the wrong situation 100%, so when you meet a incorrect library, Please inform us in time, we
will fix it as soon as possible.

There are 3 ways to report error:



1.Right-click the offical library and use the "Report Error" function on the "Libraries".

@, Library [ MIN |
Search Engine | EasyEDA | LCSC Electronicsm 1k 0603 X Q Help Verify,
Types Symbol Footprint Spice Symbol SCH Module PCB Module 3D Model
Classes Work Space LCSC JLCPCB Assembled System Follow User Contributed
Report Error &3
~ Title(PartNO) . n4
amp
{} 4D03WGJ0200T5E 3 .
j emark:
Capacitors £} RTA03-4D273JTP bl
Niobium Oxide Capacitors m—i Please fill in at least 5 words. I
Capacitor Networks, Arrays £ Edit
: D03 p o
Aluminum Electrolytic Ca... 03 4003 odify
Tantalum Capacitors . Delete
4D03! 2.
Solid Polymer Electrolytic. . o 53 Clone LNEEN|
\}
Multilayer Ceramic Capac.. {3 4D03' 4% Add Sub Part
£34D03) i B ;
Resistors Q) Add Favorite . S
4D03' € Refresh ~ Submit Cancel =
@ Refres|
Varistors S
- {34D03'  View Datasheet... B _ = S
High Voltage Resistor o
4D03! T - - -L3.2-W' 1
High Precision & Low TC... £l Report Error... w \7 RES-ARRAY-SMD_0603-8P-L3.2-W1.6-BL Extend ™ -
- K »
Rarictar Natunrlee & Arrave
EasyEDA > Symbol = JLCPCB > Resistor N & Arrays = 4D03WGJ0514T5E

LCSC Part#: C12030 Stock: 6750 Distributor: LCSC

EX K13 38

2.Select the offical library on the canvas of the schematic/schematic module, click the "Report
Error" button at the right-hand panel.

Minimum: 50

$0.0042 ¥

X Cancel

Selected Objects 1

H1

—s—]

— 2

|00
| | | | I

Header-Male-2.54 '

Component Attributes
Name Header-Male-2 54_1
Display Name Yes w
- Prefix H1
Display Prefiz Yes w
Conmvertto PCE | Yes v
Add into BOM Yos v
Locked No i
| Edit Symbaol... |
| Report Error.. |
Customn Attributes \
Footprint HDR-2X1/2.54
Display Footp... | No i



or right-click the component:

A

Find Similar Objects...

ﬂiﬂ’ Cut

53 Copy

3 Paste

. Delete b I
Update -~
Edit Symbol...

View Datasheet...

& Lock
Attributes...

3.Send Email to us or post a topic at Bug_report

support@easyeda.com

Create the Schematic Symbol

Create the Schematic Symbol

Using Schematic Symbol Wizard and Group/Ungroup... is a quick way to create schematic
symbols but they are placed directly into the schematic that they are built in.

It is possible to reuse them by copying them ( cTrRL+C hotkeys) from the schematic they were
created in and then cross-document-pasting them ( cTRL+SHIFT+v hotkeys) into a different
schematic but this quickly gets messy if you need to copy symbols that were created in several
different schematics.

OK, you could keep copying new symbols into a dedicated “symbol library” schematic sheet
to save searching for them but EasyEDA offers you an easier way to create and manage your
symbols in a library.

Start a new Schematic Lib as shown below or by doing:



1. File > New > Symbol
i E - 59 - @ - |DIZI - E‘ -
IR o |,

L Open »  I[] Schematic :
u I Save.. Crl+5 S PCB i
. Save As. ~ Schematic Lib....
B Save As Module. . {If PCB Lib ‘“
ttn_ = Print. . 3+ Spice Symbol
-([1 Export » fB Spice Subckt
last * Export BOM... <0 Schematic Module
last  Export Netlist » Z= PCB Module
wial 2 FasyEDA Source... Ej ‘ ‘
Promect - t ruwwniars i

This opens the New SchematicLib symbol editor.
2. Create the symbol

¢ Get the Datasheet
For example, using the NE555DR, the datasheet you can refer LCSC: NE555DR.
And then create the symbol and place the pins for the library base on the datasheet.
This component have 8 pins and names.

(TOP VIEW)
U 1

1 DISCH
1 THRES
1 CONT

GND
TRIG
ouT
RESET

|l |
BowW N =
| |

g oy ~ @

e Create via Schematic Symbol Wizard

@~ @ 100%~ kx - - v P+ =

500 £00 \ 700

=10

The more information of Schematic Symbol Wizard please refer next section.

e Create by Manually



o Draw the shape via the Drawing Tools

Drawing Tools _
e w
o Place the Pins
a2 B B B B B PR
Drawing Tools _
| Ly N>
1 18 . 0> O
----- @—218 TQ@@ O
—21 7N
—313 618

The Pin dot must keep out side as the image indicated, it is connecting with the
wires. The more information please refer SchematicLib Attributes - Pins Section.



3. Edit the pin map
Via Edit > Pin Map..., change Pin names and Pin numbers. For some complicated IC, will use
the alphabet for the pin number.

&~ 9~ @~ @% K e WD B Q-
Copy Chrl+C Pin Map @
[ Paste Cirl+y | # Edit Pin Map Information
Cut Cir+X - Fin Mame Fin Mumber Spice Pin Numix
- - GND 1 1
Delete Delete
) TRIG X 2
%2 Drag D
ouT 3 3
%z Schematic Library Wizard. .. RST 4 N
Edit Subckt cV 5 5
DIs [ 7
Clear
| T VCcC ] g
Unlock All

- ox | e I8

Note: if the pin is hidden, a network will be generated according to the pin name for
connection. If it is not necessary, it is recommended not to hide.

4. Modify the Detail
such as change Pin length, place text, change Pin color, Pin attributes etc.

VCC 5=
DIS [~
THRS [==
CV [ —

2 GND
< TRIG
— OUT
4 RST

NES555DR

5. Set Costom Attributes

You can set the supplier, footprint(Suggested, you must assign the footprint via "Footprint
Manager"), Name(Required), Prefix(Required) for it, the more detail of attributes please refer
below section: Custom Attributes



Custom Attributes

Supplier Unknown v
. Mounted Yes M
@_% GND g VCC %9 Package SOIC-8_150MIL
@§' TRIG g DIS g"’ Name NE555DR
2 ouT L THRS o Pre w2
= RST = CV R Contributor )

If the schematiclib need to assign the packahe, the Pin number should match the footprint's
Pad number. The detail of the footprint assign please refer the Footprint Manager section at
previous.

o [fthe part's property "Convert to PCB" is set as "No’, it will not appear at footprint
manager.

6. Set the Origin
You can via: "Top Menu - Place - Set Canvas Origin - By Center Grid of Symbols" to set the
origin.

7. Save your SchameticLib
You can set this library's owner, datasheet link and tags etc.

Save as a schematic Lib

Owner: Tutorials v Create Team

Title: MNES55DR

Manufacturer _

Part MNES55DR

Supplier: Unknown v Or| Others

Supplier Part AR

Number: 206-6501-2-MD

Link: hitp: /A ti.comfit/ds/symlink/ne555 pdf

Tags: 555 Timer -
553 Timer

Description:




Then a Schematic Symbol is created finish. And the you can find it at "Libraries - SchematicLib

- Personl" on the left-hand.
1 N I I I Y Y |

Project o -
@, Search Libraries
E Search Components, Footprints,
= 10
Types 2 SCH Libs PCE Libs SCH Modules PCE Modules
@El 1 Classes 3 Personal - LCSC ~ LCSC Assembled ~ System
Libraries
L Title{PartNQ) Package
i} NES55DR SOIC-8_150MIL
Lest
— {} ESP12E_DEVKIT ESP12E_DEVKIT
LCSC
Notice:

¢ Note the Origin Point. To simplify rotating your symbols when they are placed into the
canvas, make sure all of your symbols are created as near as possible centered around
that point. Suggesting the first Pin/Pad or its center to be the origin point.

o Please make sure all pins dot are placed on the grid, otherwise, when place the library on
the schematic will causing the wiring difficult.

Pin Attributes

Symbols pins are the most important part of any Schematic Lib symbol. They are the things
that allow wires to be attached to symbols to connect up your circuit.

You can use the P hotkey to add a Pin or from the Draw Tools pallete:

Drawing Tools —

Before placing it on the canvas, you can use the rotation hotkey or rotate and flip from the
menu to rotate it to the right orientation. Make sure the Pin Dot(black dot) is in the right
position. The Pin Dot will be used to connect your wires or netlabels. Whenever a PIN is either
placed as directly onto the canvas or as part of a symbol, the mouse has to point to the Pin
Dot position to automatically start the Wire mode or to join a wire to it.



Whenever a Pin is placed as part of a symbol, the Pin dot should be outside of — and
pointing away from — the symbol like in example 1(correct position), inside or pointing
towards the symbol as shown in example 2(wrong position).

GOOD NG
\\ 8 8
—Llvce GND|— \(ele A +——GND
—21{vDD 7L VDD —2—4} 7
examplel example2
—21GND s2— GND s

When you select a single Pin, the Pin attributes will be shown in the right hand Properties
panel:



Selected Objects 1

A P < Pin Attributes

Crientation 0° A
Start X 300
Start Y a0
Length 20
Name Voo
Number 1
Spice Pin Order | 4

VCC 1 o Mame Display Yes v
MNumber Display = Yes T
Dot Mo v
Clock Mo A
Show Yes v
Electric Undefined A
Font Family Verdana v
Font Size 7pt v
Locked Mo v

Orientation: 0°,90°, 180° and 270°, If you want to create a 45° pin, you need to set it length
as 0, and draw a line with 45°,

Start-X and Start-Y: The pindot position. Sometimes it may be difficult to move the pin to the
desired position using the mouse, so you can move the pin via Start-X and Start-Y.

Length: Pin length.
Name: In this example, VCCis the name of the Pin.

Number: In this example, 7is the number of the Pin. This number is the pin number of the
device in a physical footprint.

Note that you can use alphanumeric identifiers such as; A1, B1, C1, A2, B2 and so on as the
Number.

Spice Number: These are the pin numbers used to connect your symbol to the corresponding
pins defined by the .model or .subckt used to simulate your device. The pin numbers of the
simulation model may be different from the physical footprint pin numbers and - unless the
model is specifically created to model multiple devices in a single footprint - do not change
for different instances of a device in a multi-device footprint. The Spice Pin order must

be numerals only.

Name Display: If you don't want to show VCC switch it to NO.

Number Display: If you don't want to show 7, switch it to NO.




You can adjust the Name or Number position using your mouse but note that rotate and flip
applies to the whole pin including the name and pin number; these items cannot be rotated
and flipped independently of the pin itself.

Note also that rotate and flip actions do not result in upside down or mirrored pin number or
names.

Color: You can set the Pin to different colours, such as PIN3:CLK as orange and PIN4.GND as
blue. In this example, the PIN1 is set as color #880000, but it shows as red, because it is
selected. After deselecting it, the pin will appear color #880000 .

Dot: adds a circle to the inside end of the pin to indicate logical (or analogue) inversion.
Clk: adds a > to the inside end of the pin to indicate that the pin is logical clock input.

Selected Objects 0

240 260 280 300 4 Canvas Attributes

Background #FFFFFF
Visible Grid Yes v
Grid Color #CCCCCC
Grid Style line v

4 1 V C C Grid Size o

1 Snap Yes v

S _

Snap Size S

]

-

2 VDD ALT Snap | =
eXam]  Custom Attributes

Supplier Unknown v
¢ Mounted Yes v

package NONE

name X7 3455

GND pe A v

Manufacturer Part *7] 3455

Contributor X7 Tutorials

Show: YES/NO. Allows you to hide the pin. When set it to NO, this Pin will be hidden when the
symbol is placed on the schematic editor canvas, and then create a net which name same as
this pin name.

Note that the pin is not hidden here in the Schematic Lib symbol editor canvas because if it
was, it would disappear from view and so how would you find it to make it visible again? For
the same reason this option has no effect in symbols made using Group/Ungroup...

We may not have thought of everything in EasyEDA but we do try. :)
Electric: [Undefined, Input, Output, 1/0O, Power]

EasyEDA provides Electrical Rules Checking (ERC) right now, But you still need to set electric of
your Schematic libs.



If you set the PIN as Power and set the pin to be hidden, then the Pin will be connected by
Name which is the NetLabel. If the Name is VCC, it will be connected to the net in your circuit
with the NetLabel or NetFlag VCC. This is helps to keep the schematic clear and uncluttered
when using Multi-part Components.

After created the Lib, use cTrL+S will open the save dialog:

Save as a schematic Lib B8

Cwner: Tutorials v Create Team

Title: MES55DR

Manufacturer

Part NE5550DR

Supplier: Unknown ¥ Or| Others

Supplier Part -~ s

Number- 206-6501-2-ND

Linl: hitp:ffwwna ti. comilit/dsisymlink/ne555 . pdf

Tags: 555 Timer -
555 Timer

Description:

After clicking Save, you will see it appears in Libraries > Symbols > Personal of the left hand
Navigation panel.

" @, Search Libraries e
g Search Components,Footprints, Modules Q
&
/r, pes SCHLibs PCBLibs SCHModules PCB Modules

L

Classes Personal LCSC v LCSC Assembled System - Team v Follow v
Libraries

Title(PartNO) \ Package

o ‘ _ il L
Les,
—

LCsC

JoLe {
—
JLCPCB

SCH Libs = Personal = Created > 555 = NE555DR

23 K3 33 B8



If you want to modify the tag for your new symbol: Libraries > Symbols > Personal > Select
New Lib > More > Modify, or right-click new Lib > Modify, if your Lib doesn't have the tags
it will appears on All.

&, Search Libraries &, Search Libraries
Search Components,F¢ Search Components,Footprints,Modules Q
SCHLibs PCBLibs SCHModules PCBModu Type SCHLibs PCBLibs SCHModules PCB Modules
Classes Personal LCSC v LCSC Assembled 8| Classes Personal LCSC v LCSC Assembled System Team ™ Follow ™
Title(PartNC Title(PartNO) Package
@ Created Modify file info B8
All 555 Interface ICs Just For Test X Delete Title NES550R
nvihg 3 Clone
. ﬁ Add Sub Part Description:
Favorite Q© Add Favorite
Al High Precision & Low TCR SMD Resistors %5 Refresh Tags 555; Timer I -
=1
Custom Attributes
In the Schematic Lib editor's canvas Properties panel, you will find a Custom
Attributes section:
Custom Attributes
Supplier Unknown v
: T Mounted Yes v
iy = 8.
2 GND (o) VCC 7 Package SOIC-g_150MIL
: 3 TRIG g DIS 6 ® Name NE555DR
2 ouT L THRS c” Pre "
(Sh— )
RST = CV Contributor *)
Add Parameter

o footprint

How to change Schematic Symbol's footprint? If you would like to built a PCB, you need to
assign a footprint for your Schematic symbol. Although there are other ways to do this in
EasyEDA, here is the right place to do it. When you set a footprint , the footprint's pad
numbers must match the schematic Lib's pin number, otherwise, when you convert the
schematic to PCB , there will miss several nets.

Click in the footprint input box, and the Footprint Manager dialog will open as used to do
this task in the Schematic Editor.

The more information please refer to Schematic - Footprint Manager section.

Notie:

You have to assign the footprint via the Footprint Manager, otherwise, the Schematic lib will
not get the footprint correctly. The footprint is linked with SchematicLib by global unigue ID
not the title.

e Prefix

The default Schematic symbol Prefix is U? If you create a resistor, you can set the Prefix to R?.
It is filled required.



e Name
You can change the schematic lib's name here, it is can be different from the part's file name.
e Contributor

This is your registered user name. When Other EasyEDA's users use your libraries, they will
remember your contributions!

Symbol Subparts

We have already touched on how EasyEDA can support Multi-part/Subpart Components,
but how do you create multi-part components?

EasyEDA provides a sub parts facility to do this.

After creating a part, you can right-click the part in the Library > Symbols > Work Space >
Created section to pop up the content menu.

Suppose you have created your own symbol for a 74HCT04 hex inverter.

{F PMOS |C-S0T23MOS
T r—
71 RES # Modify

T CONSA # Delete

==
‘ {1 ANT 3 _oné

o cAP  Add Sub Part “

; 7 Add Favaorite

"} CONBA

e €% Refresh

SCH Libs = Personal = MEL 1w rewer s

Right Click Add sub part and that will add 74HCT04.7,
Click again to add 74HCT04.2, up to 74HCT04.6.
Then double click on each sub part in turn to modify the Pin Name and Number attributes.

Easy or what?
Schematic Symbol Wizard

How many times have you hit a schematic capture roadblock because you couldn't find
a component symbol?

Well, in EasyEDA that would be never because the Schematic Symbol Wizard provides a
quick and easy way to create a general Schematic Symbol symbol.

Via: Top Menu - Tools - Symbol Wizard



Flace Format Wiew Tools Advanced Setting Help

Start 1 *Mutliple | IR Symbol Wizard... W 3 3 *Simulz
Footprint Manager.™

=240 =220 160 -140
11 1 111 | 1 111 1 111 | 2 | 1 111 | 1 111 1 111 | |
Pin Manager...

o0
=

Basic Function

Input the Pins' name Only

1. Using the NE555 timer as an example: this device is available in a DIP8 package so select
DIP. Then enter the NE555 pin names into the Pin Names text box separated by new line
or space, Then press OK. Abracadabra! As if by magic, you will find a perfectly formed
dual in line 8 pin symbol for the NE555 attached to your mouse cursor, ready to be
placed! You just need a few seconds to build a NE555 symbol, quickly and easily.

Symbol Wizard
v
Prefix u? A1 ping [
2l pin2 pin7 [
Name: NES55 d A
== PINZ PING [—
Style @pip-a Opir-8 Oarp O siP Homa  pns 1 P 8
Pin Information: S G N D VCC —®
GlD 2 7
e =51 TRIG DIS [—
— our 3 6
T =JOUT  THRS [~
(Y
THRS 4 5
IS e S C =
o RST V

The professional function please refer at: Symbol Wizard

Lo ] o IO

2. The EasyEDA Schematic Symbol Wizard allows you to create DIP, QPF or SIP styles
symbols. If you are designing Arduino Shields then you will need lots of SIP symbol, so
you can create a SIP symbol like the one shown below in a few seconds.

P1
SIP5

®
VCC

101
102
103
GND

|Ln |-l=.. |t..-c- I_h.;u |l—~

3. If you are not too worried that the symbols may not look quite the way people might
expect and that they may not look anything like the Type you select, then of course you



can use the wizard to create symbols for any component:

Q1
2N30935

C
B
E

oo o s

Input the Pins' number and name

Schematic Symbol wizard support you input the pins' number and name.
As below example, setting every pin's number is easily.

Symbol Wizard 8
.

Prefix: u? o1 ping (&

22 pin7 [
Name NESS5 ] R

ez PING &
Style @pip-A Opir-e Oarp OsiP Homs  omsf-

i|e 8

Pin Information @y G N D VCC r—®)
1, GND 2 7
2, TRIG =51 TRIG DIS [
3, out — 3 - ~ - 6
s — —10UT THRS [
5, CV
6, THRS 4 5
7, DIS 4 RST CVpr—
8, VCC

The professional function please refer at: Symbol Wizard

Professional Function

Schematic Symbol Wizard support the professional function, it is easier to create the large and
complex and more convenient Schematic Symbol.

1.Download Schematic Symbol Wizard Template.xIsx

2.0pen it via Excel or WPS, and edit each Pins attributes and position, and then copy the
content and paste in wizard dialog without content title.
Tip: If you want to create the gap between Pin and Pin, you can use the * as below image.



A B C D E F G H

1 Please copy the content without title, and paste on the schematic library wizard.

2 Number Name Number Display Name Display  Clock Show Electric Position
3|1 GND Yes Yes No Yes Undefined  Bottom
412 TRIG Yes Yes No Yes Undefined Left

5 * * * * * * * Left
6|3 ouT Yes Yes No Yes Undefined Left
7|4 RST Yes Yes No Yes Undefined Top

8 * * * * * * * Top
9|5 cv Yes Yes No Yes Undefined  Right
10 * * * * * * * Right
11| 6 THRS Yes Yes No Yes Undefined  Right
12 * * * * * * * Right
13|7 DIS Yes Yes No Yes Undefined  Right
14| 8 vCC Yes Yes No Yes Undefined Top
15

16

3.The Wizard will create the symbol follow your content. The types you chosen will be ignored.

Symbol Wizard
.
Prefix: u? Aot
2l o2
Name: NE555 A
- PIN2
of <l
Style: @pip-a Opir-e Oarp O siP Aoma N
* U |~
Pin Information: U (n
1 GND Yes Yes No Yes Undefined Bottom > 7
2 TRIG Yes Yes No Yes Undefined Left DIS )
® * * ® * * = Left 2
3 OUT Yes Yes No Yes Undefined Left == TRIG
4 RST Yes Yes No Yes Undefined Top |6
_ S ) TLDC
S OV Yes Yes No Yes Undefined Right —_— 3 IRo
= x= = = x = = Right e OUT
6  THRS Yes Yes No Yes Undefined Right 5
* * * = * * = Right CV _
7 DIS Yes Yes No VYes Undefined Right
8 VCC Yes Yes No Yes Undefined Top CD
=
y O
The professional function please refer at: Symbol Wizard =

Notice:

o /fthe content you input wasn't one, two or eight columns, it will shown incorrect format.
e You can use the Key Space to separate the column data.

Schematic Symbol Attributes

Pin Attributes

Symbols pins are the most important part of any Schematic Lib symbol. They are the things
that allow wires to be attached to symbols to connect up your circuit.

You can use the P hotkey to add a Pin or from the Draw Tools pallete:



A B C D E F G H

1 Please copy the content without title, and paste on the schematic library wizard.

2 Number Name Number Display Name Display  Clock Show Electric Position
3|1 GND Yes Yes No Yes Undefined  Bottom
412 TRIG Yes Yes No Yes Undefined Left

5 * * * * * * * Left
6|3 ouT Yes Yes No Yes Undefined Left
7|4 RST Yes Yes No Yes Undefined Top

8 * * * * * * * Top
9|5 cv Yes Yes No Yes Undefined  Right
10 * * * * * * * Right
11| 6 THRS Yes Yes No Yes Undefined  Right
12 * * * * * * * Right
13|7 DIS Yes Yes No Yes Undefined  Right
14| 8 vCC Yes Yes No Yes Undefined Top
15

16

3.The Wizard will create the symbol follow your content. The types you chosen will be ignored.

Symbol Wizard
.
Prefix: u? Aot
2l o2
Name: NE555 A
- PIN2
of <l
Style: @pip-a Opir-e Oarp O siP Aoma N
* U |~
Pin Information: U (n
1 GND Yes Yes No Yes Undefined Bottom > 7
2 TRIG Yes Yes No Yes Undefined Left DIS )
® * * ® * * = Left 2
3 OUT Yes Yes No Yes Undefined Left == TRIG
4 RST Yes Yes No Yes Undefined Top |6
_ S ) TLDC
S OV Yes Yes No Yes Undefined Right —_— 3 IRo
= x= = = x = = Right e OUT
6  THRS Yes Yes No Yes Undefined Right 5
* * * = * * = Right CV _
7 DIS Yes Yes No VYes Undefined Right
8 VCC Yes Yes No Yes Undefined Top CD
=
y O
The professional function please refer at: Symbol Wizard =

Notice:

o /fthe content you input wasn't one, two or eight columns, it will shown incorrect format.
e You can use the Key Space to separate the column data.

Schematic Symbol Attributes

Pin Attributes

Symbols pins are the most important part of any Schematic Lib symbol. They are the things
that allow wires to be attached to symbols to connect up your circuit.

You can use the P hotkey to add a Pin or from the Draw Tools pallete:



Drawing Tools —

Pin Orientation

Before placing it on the canvas, you can use the rotation hotkey or rotate and flip from the
menu to rotate it to the right orientation. Make sure the Pin Dot(black dot) is in the right
position. The Pin Dot will be used to connect your wires or netlabels. Whenever a PIN is either
placed as directly onto the canvas or as part of a symbol, the mouse has to point to the Pin
Dot position to automatically start the Wire mode or to join a wire to it.

Whenever a Pin is placed as part of a symbol, the Pin dot should be outside of — and
pointing away from — the symbol like in example 1(correct position), inside or pointing
towards the symbol as shown in example 2(wrong position).

GOOD NG
N\ 8 8
—Llvce GND — \ele A +——GND
—2-1VDD y] A VDD —2—4 7
examplel example2
4 { GND 512 GND 2 s

Pin Attributes

When you select a single Pin, the Pin attributes will be shown in the right hand Properties
panel:



Selected Objects 1

A P < Pin Attributes

Crientation 0° A
Start X 300
Start Y a0
Length 20
Name Voo
Number 1
Spice Pin Order | 4

VCC 1 o Mame Display Yes v
MNumber Display = Yes T
Dot Mo v
Clock Mo A
Show Yes v
Electric Undefined A
Font Family Verdana v
Font Size 7pt v
Locked Mo v

Orientation: 0°,90°, 180° and 270°, If you want to create a 45° pin, you need to set it length
as 0, and draw a line with 45°,

Start-X and Start-Y: The pindot position. Sometimes it may be difficult to move the pin to the
desired position using the mouse, so you can move the pin via Start-X and Start-Y.

Length: Pin length.
Name: In this example, VCCis the name of the Pin.

Number: In this example, 7is the number of the Pin. This number is the pin number of the
device in a physical footprint

Note that you can use alphanumeric identifiers such as; A1, B1, C1, A2, B2 and so on as the
Number.

Spice Number: These are the pin numbers used to connect your symbol to the corresponding
pins defined by the .model or .subckt used to simulate your device. The pin numbers of the
simulation model may be different from the physical footprint pin numbers and - unless the
model is specifically created to model multiple devices in a single footprint - do not change
for different instances of a device in a multi-device footprint. The Spice Pin order must

be numerals only.

Display Name: If you don't want to show VCC switch it to NO.

Display Number: If you don't want to show 7, switch it to NO.




You can adjust the Name or Number position using your mouse but note that rotate and flip
applies to the whole pin including the name and pin number; these items cannot be rotated
and flipped independently of the pin itself.

Note also that rotate and flip actions do not result in upside down or mirrored pin number or
names.

Color: You can set the Pin to different colours, such as PIN3:CLK as orange and PIN4.GND as
blue. In this example, the PIN1 is set as color #880000, but it shows as red, because it is
selected. After deselecting it, the pin will appear color #880000 .

Dot: adds a circle to the inside end of the pin to indicate logical (or analogue) inversion.

Clock: adds a > to the inside end of the pin to indicate that the pin is logical clock input.

s -
Mumber 2

2 Spice Number 2
Dizplay Mame Mo L
Display Mumber | yes w
Length No
Orientation 0° w
Start X 20
Start ¥ 0

Show: YES/NO. Allows you to hide the pin. When set it to NO, this Pin will be hidden when the
symbol is placed on the schematic editor canvas.

Note that the pin is not hidden here in the Schematic Lib symbol editor canvas because if it
was, it would disappear from view and so how would you find it to make it visible again? For
the same reason this option has no effect in symbols made using Group/Ungroup...

We may not have thought of everything in EasyEDA but we do try. :)
Electric: [Undefined, Input, Output, I/O, Power]

EasyEDA provides Electrical Rules Checking (ERC) right now, But you still need to set electric of
your Schematic libs.

If you set the PIN as Power and set the pin to be hidden, then the Pin will be connected by
Name which is the NetLabel. If the Name is VCC, it will be connected to the net in your circuit
with the NetLabel or NetFlag VCC. This is helps to keep the schematic clear and uncluttered
when using Multi-part Components.

After created the Lib, use cTrL+S will open the save dialog:



Save as a schematic Lib 8

owner: Tutorials v Create Team

Title: MESS5DR

Manufacturer

Part: MESS5DR

Supplier: Unknown ¥ Or| Others

Supplier Part o

NUMber: 296-6501-2-MD

Link: hitp:ffwwna ti. comilit/dsisymlink/nes55 . pdf

Tags: 555 Timer -
555 Timer

Description:

After clicking Save, you will see it appears in Libraries > Symbols > Personal of the left hand
Navigation panel.

N . .
©, Search Libraries 8
g Search Components,Footprints, Modules Q
V -
/Types SCHLibs PCBLibs SCHModules PCB Modules
U

@ Classes Personal v LCSC v LCSC Assembled v System v Team v Follow v

Libraries

Title(PartNO) \ Package
I
Loy
~—

LCSC

LL:L.

JoLe {
e
JLCPCB

SCH Libs = Personal > Created > 555 > NE555DR

EXE KIZE K33 EXTE

If you want to modify the tag for your new symbol: Libraries > Symbols > Personal > Select
New Lib > More > Modify, or right-click new Lib > Modify, if your Lib doesn't have the tags
it will appears on All.

&, Search Libraries @, Search Libraries
Search Components,F¢ Search Components,Footprints,Modules Q
Types SCHLibs PCBLibs SCHModules PCBMody Types SCHLibs PCBLibs SCHModules PCB Modules
Classes Personal LCSC v LCSC Assembled v 8| Classes Personal v LCSC v LCSC Assembled v System v Team v Follow v
Title(PartNC [IRSLT e Title(PartNO) Package
1 K Delete
All 555 Interface ICs Just For Test Title: NESSSDR
néviag 3 Clone
Favorite 4} Add SubPart Description:
O Add Favorite
Al High Precision & Low TCR SMD Resistors % Refresh T 555 Timer V4 .



Symbol Custom Attributes

In the Schematic Lib editor's canvas Properties panel, you will find a Custom
Attributes section:

Customn Attributes

AddInto BOM | Yes v
Convert To PCE | ves -
Marme C_0603_US
Footprint COs03
Pre 7

- -}
Supplier Unknow -
Supplier Part

Value(F)  *7  pu

Contributor LCEDA_Lib

‘ Add Parameter |

Y

| view Datasheet |

e Add into BOM
This part display at BOM or not.

e Convert to PCB
If you set it as No, this part will not display at Footprint Manager and can't not convert to
PCB.

o footprint
To assign a footprint for this part. Only assign one footprint.
The more information please refer to Schematic - Footprint Manager section.
Notie:
You have to assign the footprint via the Footprint Manager, otherwise, the Schematic
Symbol will not corresponding the Footprint correctly. The Footprint is linked with
Symbol by global unique ID not the title.

* Pre
The default Schematic symbol Prefix is U? If you create a resistor, you can set the Prefix to
R?. It is filled required.

e Name
You can change the schematic lib's name here, it is can be different from the part's file
name.

e Contributor
This is your registered user name. When Other EasyEDA's users use your libraries, they
will remember your contributions!

Show symbol value as component name when place
component at schematic
For example, a resistor symbol vaule is 2KQ, name is ABC, but when place it at schematic, it

will not show 2KQ as component name, the name is ABC. You can change name to 2KQ, but it
not very well.



EasyEDA doesn't support common function to support this feature yet.

But, we can edit the symbol file soure to implement this feature.
How do it works:

1. Finish symbol and parameter edit.

2. Open file source. via: Top Menu - File - EasyEDA File Source.
SasyEDA sto File Edit  Place

Format WView Tools Advanced
. Le New " [ 555 Timer - Flash... | F
llL‘ Gpen Prﬂ-le':t | L1 11 -EII:"I:II 1 | L1 11 |-5II:"I:II 1
Supply Flag & Open
[d save... Ctr+S
Save As..
. g= |Import b
GND '
GND Ground(1[= Export 3
Resistor .+ [EasyEDA File Source...

3. Add or modify the parameter: nameAlias.

&5 EasyEDA Source

Copy the contents of this box into & text editor, then save the file. Paste the edited text back int
{
"head": {

“dDCTypE“ : IlzllJ
"editorVersion": "6.4.3",
"newgId": true,

“c_para": {

"package": "RO&B3",
"name": "R_©683_US",

nr“f—"“- IIR?!I

"nameAlias™: "Value(D)",
"Walue(Q)": "1k",

"BUOM_5Supplier Part™: 77,
"BOM_SL’IppliEr"“ . LR s

"Contributor": "“LCEDA Lib"

¥

"¢ spiceCmd": null,
"hasIdFlag": true,

This symbol will show 1k as component name after placing at schematic.
4. Apply after modified, and save.

You can double click the EElib resistor symbol to get an example.

EasyEDA will provide it as a feature in the future.

Edit Exited Schematic Symbol



Personal Libraries

When you CTRL+S to save the Schematic Symbol, will pop up a dialog, you can choose this

library's owner:

Save as Symbol
Owner: UserSupport v  Create Team -
Title: C_0603_US I
Supplier: Unknow v Or Others
Supplier Part: 296-6501-2-ND
] Manufacturer:  ReliaPro

Manufacturer

Part: NE555DR

Link: hitp:/iwww. ti.com/lit/ds/symlink/ne555 .pdf
Tags: Split by *;' for multi tags

Description:

v

I

After finish, you can find your library at the left panel: Library > Symbols > Work Space > All

&, Library

{F

EELib Search Engine | EasyEDA LCSC Elec'(ronicsmalzg

Search symbol, footprint etc.

Types Symbol Footprint  Spice Symbol SCH Module PCB Module 3D Model
Q Classes Work Space LCSC JLCPCE Assembled System Follow
Library
amp W& Title(PartNO) Footprint
\ {F NCP1M17ST18T3G SOT230P700X180-4N
@ My Libraries ] NESS55 SOP-8
Pars | S - cock corv SIP220P-2
V
DEVRIT {FR_1812_US R1812
e My Favorites {3 ESP12E_DEVKIT ESP12E_DEVKIT
JLCPCB All
thisateamfortest
All
Tag

When you select it , right-click it and select the menu "modify”, you can add a tag for it.



Title(PartNO) Footprint Description

NcrrmsTIoTo T T

{3 NE555 SOP-8 UserSupport

I {} 2 HEADER COPY SIP220P-2 UserSupport
{IR_1812_US R1812 UserSupport aaaaa
{1 ESP12E_DEVKIT ESP12E_DEVKIT UserSupport

= All > NCP1117ST18T3G

-m-

£ Edit

X Delete | \

53 Clone
¥ Add Sub Part

Favorite

When you favorite a library, you can find it at Library > Symbols > Work Spacel > Favorite ,
If this library has a tag, the tag will show up too, but you can't edit that.
But you can via "Clone" or "Edit and save" to create a new library to personal libraries.

Title{PartNQ) Footprint
[ Em prowaen
7} NE555 £ Modify
B o enoer copy ¥ Delete -2
TIR_1812_US B3y Clone
{F ESP12E_DEVKIT 3t Add Sub Part _DEVKIT
(0 Add Favorite
@ Refresh
View Datasheet...

Report Error...
View Owner

View Detail

Edit Symbol in the Library

When you feel the Schematic Libs can not be satisfied for you, you can edit it.
Via "Library" > "Search Part/Work Space/LCSC/System” > Select Symbol > Edit

or you can click the preview image



@, Library MIN it

EELD Engine | EasyEDA | LCSC Electronics ™ Search symbol, footprint etc Q Help Verify
Symbol Footprint Spice Symbol SCH Module PCB Module 3D Model
Q Classes Work Space LCSC JLCPCB Assembled System Follow
Library ‘
mp Title(PartNO) Footprint Owner Description
il NorsriTac sorzmerovaom ——Jumopen | [
My Libraries fom| '
Lo y £ NE555 SOP-8 UserSupport -
Parts _ {} 2 HEADER COPY SIP220P-2 UserSupport
DEVKIT
{}R_1812_US R1812 UserSupport aaaaa
ips My Favorites {1} ESP12E_DEVKIT ESP12E_DEVKIT UserSupport
JLCPCB All

thisateamfortest
All

EasyEDA Team
All

¥
EX1 KIZ3 33 BTSN

EasyEDA > Symbol > Work Space > All > NCP1117ST18T3G

o

when you finish and save, it will be saved to your personal libraries Work Space and become
your personal libraries.

Edit Symbol in the Schematic

If you want to edit a symbol in the schematic, you can use the Ungroup/Group function.

On the Wiring Tools palette there is the Group/Ungroup Symbol... button.

Wiring Tools —_

Lk N7
X e B

This tool is for you to quickly create or edit schematic library symbols.

1. Select a symbol

2. Click the Group/Ungroup Symbol... button
Up to this point you have a collection of separate pins, a drawn rectangle and some text
that are all separate items with no particular association with each other.

3. Edit the shape or pin what you want to change

4. Select all of the items and click the Group/Ungroup Symbol... button.
A dialog will be opened:



Group these items as a SCHLIB/Symbol

Prefix:

Mame:

Please assign the package at right panel

Package: after created the symbaol.

Keep these fields empty if you just want to build a

symbol
o

After you click OK, all those separate elements will be grouped together to form your new
symbol directly in the schematic.

Using the group function, you can create/edit any symbol in the schematic, easily and quickly.

PCB Layout

Canvas Setting

After the initial conversion of a schematic to PCB, it is time to learn how to manage EasyEDA's
PCB Design Editor.

Canvas Attributes

Lots of PCB canvas attributes are the same as Schematic canvas attributes. The key is that you
can set units in PCB canvas attributes.



